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Overview: 
 
Conserving endangered species often requires a balancing of the biological needs of endangered 
populations against the human desires for economic and recreational opportunities.  At least 
some biological aspects of every species are poorly understood, some do have large data sets that 
can be difficult to interpret.  All are confounded by human interactions.  Computational science 
allows visualization, analysis, and interpretation of large data sets in ways that can inform these 
complex biological and environmental problems.  This module will allow students to explore one 
of the fundamental paradigms of conservation biology, island biogeography, and apply that 
theoretical ecological concept to a real-world problem by creating models for habitat 
management.  Specifically this module reviews island biogeography as it applies to forest 
fragmentation in northern Michigan and uses the related concepts to explore applications to 
preservation of the endangered Kirtland’s warbler (Dendroica kirtlandii).  Students will learn 
fundamental ecological concepts, visualize and analyze large spatial data sets of an endangered 
species using a free but sophisticated geographic information system (GIS), and develop an 
environmental impact statement formatted output to explain recommendations based on their 
analysis of the data and developed models.   
 
Visualization: 
 
This module is intended for an environmental science course or an introductory biology course.  
Using the same data, but asking more complex questions, this module can readily be adopted to a 
major’s level ecology course.  For example, the module illustrates island biogeography and how 
data are collected and used in a field science such as conservation biology.  An emphasis on 
NEPA (the 1969 National Environmental Policy Act) and the NEPA-required environmental 
impact statements (EIS) and decision processes would make the module useful in an 
environmental science course.  A focus on the nature of the scientific method, the role of 
paradigms and how they change in science, or an extended discussion of endangered species 
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management and the social costs and benefits might make the module useful in a more 
philosophical course.   
 
The module assumes no background with geographic information systems (GIS), although 
instructor familiarity with the software would obviously be useful to decrease the learning curve.  
The GIS software used, ArcExplorer, is the GIS viewer developed by ESRI (Redlands, 
California), a GIS industry leader, and is built on a simplified software engine of their ArcGIS.  
Thus it serves as an excellent introduction to GIS concepts and software use with a low student 
learning curve and no required investment in expensive GIS software and hardware.  The module 
assumes a very basic understanding of computer use, including opening spreadsheets, copying 
and pasting material, and basic Windows file management.   
 
The module assumes familiarity with basic math concepts and comfort understanding and 
applying basic algebraic formulas, but does not require significant previous course work in 
programming, biology, or other sciences.  The intent of this module is to introduce the student to 
the power and potential of quantitative spatial analysis without requiring detailed understanding 
of the mathematics.  It is analogous to learning to drive a car without being an auto mechanic.   If 
you intend to stay on familiar, well-traveled roads, you might not need to know much about auto 
mechanics.  But as you drive more and leave familiar, traveled roads, an understanding of auto 
mechanics can make a huge difference.  Here the student will be introduced to how 
computational biology informs, and learn some of the basic applications.  Other more advanced 
modules proved the advanced analysis.  The module details are layered such that a more 
advanced science class can address more sophisticated questions and evaluate primary literature, 
but this module is intended to show how computational science ideas can be applied at all levels 
of college education, particularly in introductory science courses.  The data supplied, however, 
are real and are the very same data that biologists with state and federal agencies use to 
determine the viability of an endangered species and manage the habitat for that species.  
Confidential details, such as names of landowners or researchers’ personal notes, have been 
removed, but otherwise these data represent the very level of detail used to manage Kirtland’s 
warblers in Michigan. 
 
When completed, students will understand several fundamental concepts in conservation biology 
including island biogeography and forest fragmentation.  They will be able to use ArcExplorer to 
examine and query spatial data.  They will be introduced to the process of environmental 
decision making and apply their analysis of spatial data related to an endangered species to 
solving a real problem of conflicting land use.  
 
Introduction to the problem:  
 
An examination of the population and habit needs of Kirtland’s warbler (Dendroica kirtlandii), 
makes for an interesting look at how biologists work with endangered species, and offers one test 
of island biogeography.  It also provides an example of the real-world constraints on endangered 
species management. 
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Figure 1. Kirtland’s warbler (Dendroica kirtlandii) perched in jack pine (Pinus 
banksiana).  By 1970 only 200 singing males survived.  Efforts to restore this 
species have succeeded largely through habitat management. 

 
Kirtland’s warbler is a small, endangered migratory bird with very specialized habitat needs 
(Figure 1).  While winter range in the Bahamas had been known previously, it was not until 1903 
that the critical summer nesting range was identified in northern Michigan (Adams 1903).  
Probst (1986) provides a succinct review of the known biology of the warbler and the identified 
threats.  He suggests that habitat management of the northern forest may regulate or limit the 
population, and his work and other supporting papers have led to the current management 
strategies for this species.  Probst notes that the known nesting range is limited to an area 120 by 
160 km (now slightly expanded from that) in Lower Michigan (Figure 2).  The warbler nests and 
feeds in stands of jack pine (Pinus banksiana), originally of wildfire origin, between 2 and 5 
meters height (roughly 5 to 15 feet), which means stands aged approximately 5 to 15 years of 
age.   
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Figure 2. Summer range map of Kirtland’s warbler.  By far, most warblers are 
recorded in the eight counties indicated in Lower Michigan. 

 
Such forests occurred naturally before human settlement as a result of wildfires that burned 
through the sandy counties of northern Lower Michigan.  With settlement came a suppression of 
wildfires and the subsequent loss of appropriate habitat, and numbers of Kirtland’s warblers 
decreased.  The first census of Kirtland’s warblers, taken in 1951, showed 432 males (Mayfield 
1953).  Numbers decreased into the 1970s to 201 males. Confounding the problem was this and 
other warbler’s susceptibility to nest parasitism by cowbirds (Molothrus aeneus) (Figure 3) 
(Mayfield 1961, May and Robinson 1985).  These avian brood parasites lay their eggs in the 
nests of other host bird species and the hatching young out compete the original nest residents for 
the parental food.  Nest parasitism was a relatively small problem until human settlement opened 
forests and created ideal habitats for cowbirds.  Once cowbird numbers were limited to prairie 
areas and followed roaming buffalo for food, and nest parasitism was the only viable way to rear 
young as the parent could not remain in place long enough to raise the young and still follow the 
mobile food source.  Cowbird nest parasitism significantly reduced population recruitment for 
Kirtland’s warbler. 
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Figure 3.  Brown headed cowbirds (Molothrus aeneus) are nest parasites, laying 
their own eggs in the nests of hosts, including Kirtland’s warblers.  This 
contributed significantly to the decline of Kirtland’s warblers, and lead to one of 
the successful management strategies of cowbird removal through U.S. Fish and 
Wildlife service trapping. (US Fish and Wildlife photographs). 

 
The Endangered Species Act of 1973 authorized the United States Forest Service (USFS) and 
other national, state, and local agencies to create a Kirtland’s Warbler Recovery Team.  That 
team created a plan in 1976, since updated (Kirtland Warbler Recovery Team 1985).  The plan 
calls for annual Kirtland’s warbler censuses, cowbird population control, closure of breeding 
areas to human use during warbler nesting, and habitat management for the warbler’s specialized 
jack pine forest needs.  Creation and maintenance of large tracts of one forest type requires large 
landholdings on the right type of soils.  Although sighted occasionally in Wisconsin and Ontario 
(Figure 2), the only known successful warbler nests have been in Michigan, almost all on state 
and federal land.  Therefore habitat management of this endangered species centers on the 
Michigan Department of Natural Resources and the U.S. Forest Service, Huron-Manistee 
National Forests.  Cowbird population control falls to the U.S. Fish and Wildlife Service, which 
removes three to five thousand cowbirds each year.   
 
The annual census of Kirtland’s warblers shows a species finally on the road to recovery.  
Although Dennis et al. 1991 suggest otherwise, their data do not include the exponential growth 
increases of the last decade.  Their concern over stochastic and catastrophic losses to such a 
geographically limited species still apply.  The annual census sends teams of trained observers 
into known and suspected Kirtland’s warbler habitats prior to nesting, when male Kirtland’s take 
to the tops of trees to sing, marking territory.  Males are easily located, and most areas are can be 
observed by more than one team, allowing triangulation of locations to prevent double counting.  
It appears that there are females for each singing male.  Some males are polygamous, and some 
non-breeding birds exist, so the annual census of males provides a consistent measure of the 
species over time and probably accounts for a little under half of the total birds alive.  Using 
known locations and known habitat needs, both sate and federal land managers began an intense 
habitat management program.  The habitat investments begun in the 1970s began to pay 
dividends in the late 1980s as habitats became available, and now warbler populations are three 
times higher than when the census first began (Figure 4). 
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Figure 4.  Kirtland’s warbler numbers decreased from 1950 to 1970.  A decade of 
habitat management and cowbird controls stopped the population decline, and 
now numbers are rapidly climbing.  Censuses for this species use counts of 
singing males, which are easily located in the spring.  There is at least one female 
for each singing male. 

 
Kirtland’s warbler was declared an endangered species in the original Endangered Species Act of 
1973.   Creation of properly aged habitats requires logging significant amounts of forest habitat 
to create open areas where jack pine forests will regenerate.  While fire provided the historic 
habitats for Kirtland’s warbler, local residents, and the risk of large conflagrations limit the role 
fire can play in this ecosystem.  However, a brief look at the effects of one such large fire clearly 
show the role fire played in the warbler’s historic ranges, and why prescribed burns are now 
limited. 
 
On 5 May 1980, a small fire was started by U.S. Forest Service personnel as a prescribed or 
intentional burn to reduce logging leftovers and prepare a site for jack pine regeneration.  The 
intended burn of a few acres got out of control and before the day was over killed one U.S. 
Forest Service ranger, destroyed 44 homes, and burned 20,000 acres of forest (Simard et al. 
1983).    The fire became so intense that it began a firestorm, drawing in huge quantities of air 
and releasing enormous amounts of energy as heat and light.  By the time the fire was controlled 
another 4000 acres had burned and the blaze released as much energy as 9 Hiroshima atomic 
bombs. While this was the largest U.S. Forest Service in the area ever, Simard et al. (1983) list 
many other large fires in the area outside the USFS boundary and estimate one fire over 10,000 
acres roughly every 30 years since logging began in area during the 1800s, well before USFS 
management of the area began.   
 
While tragic in its loss of life and property, and the effects it would have on limiting future 
prescribed burns, this Mack Lake burn created an ideal area to study Kirtland’s warbler habitat 
colonization, a natural experiment of the habitat specificity of the warbler.  USFS biologists 
monitored the burn area, and annual census showed 14 males had occupied the area by 1986, 
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when the jack pine were just 5 years old.  Numbers climbed rapidly as more birds found the 
habitat (immigrated to the large habitat island) peaking in 1994 at 300, and then falling rapidly as 
the jack pines aged, so that by 1999 there were only 10 males recorded, two in 2000, and none 
since (Figure 5).  With that loss of life and property, prescribed burns are now quite limited and 
cannot provide the habitat areas called for by the Kirtland’s Warbler Recovery Team.  To 
simulate fires, large tracts of land are clear cut. 
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Figure 5.  Population response to the 24,000 acre Mack Lake fire in northern 
Lower Michigan.  Kirtland’s warblers occupied the site in 1986, just 6 years after 
the fire, and numbers peaked 14 years after the fire.   

 
Commercial logging of existing forest requires jack pines to reach an age of 40 or 50 years to be 
profitable to harvest, so new habitats need to be regularly logged, mature 5 years to begin 
attracting warblers, produce warblers for a decade, and then left to mature an additional 25-35 
years to reach a point where profitable logging can occur.  Cutting the habitats earlier would 
require large amounts of money to subsidize the noncommercial cutting of forest, something 
state and federal agencies cannot fiscally afford and to which the public has objected.  As it is, 
one to two million dollars are spent annually by the USFS and Michigan Department of Natural 
Resources (MDNR) managing for Kirtland’s warbler.   
 
Clear cutting these large tracts of land, however, fragments the forest and impinges on other 
endangered species that require more traditional undisturbed land.  Conversely, these clear cuts 
need to be near occupied warbler habitats to attract new birds.  Larger habitat islands have been 
shown to be better for the warbler.  The Huron-Manistee National Forest received a waiver of the 
40 acre clearcut limit placed in the National Forest Management Act and now makes cuts up to 
550 acres in size.  MDNR has cuts up to several thousand acres on state land.  Most recreational 
forest users, however, prefer older forest over recently clear-cut land that appears unsightly and 
does not support camping, hiking, hunting, cross country skiing, and other outdoor uses. 
 
Science offers the theoretical framework for managing the species in question and allows 
assessment of the management practices by evaluating changes in the population.  Field studies 
showed the role of fire in habitat creation, the effects of brood parasites, and the overall decline 
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in the warbler populations.  As warbler numbers increase, habitat closed to the public to protect 
nest sites increases.  At the same time, pressure for public recreational space has increased.  
Federal law required action, and managers applied the biological information to their setting, 
successfully controlling cowbird nest parasitism and increasing habitat available, with the 
subsequent increases in warbler populations.  Federal law determines the operating environment 
and establishes the priorities for species conservation and annual budget allocations from 
congress finance (and set financial limits) on species conservation.  Individual and public input 
on the manifestation of these constraints determines priorities and outcomes.  Thus public 
demand for recreation trails, hunting and camping lands, commercial timber, and other uses 
protected by law limit what agencies can do for the Kirtland’s warbler, and affect where they 
manage for the species.   
 
In this computational science module, students will assume the role of a U.S. Forest Service 
biologist, review and analyze data related to the Kirtland’s warbler populations, consider several 
aspects of recreational use of the forest, and using a simple model for population management, 
make recommendations for the Huron-Manistee National Forest regarding where and how much 
warbler habitat to make, and project long-term goals for Kirtland’s warblers all within the 
confines of public demand and federal regulation. 
 
Statement of the problem: 
 
Kirtland’s warblers are a federally-protected endangered species, and by both law and public 
demand, management for them is focused on increasing population levels to long-term viable 
levels.  Public demand for outdoor space, particularly for recreational use, but also for other 
resource uses, conflicts with protecting Kirtland’s warblers, and makes deciding where and how 
much habitat to create problematic.  Students will examine data on Kirtland’s warbler 
populations and habits used, consider conflicting resource requirements, and make 
recommendations for endangered species management. 
 
Background information – scientific, mathematical, and computer: 
 
Science, as a way of knowing, yields remarkable results allowing for innovations in medicine, 
consumer technology, and conservation of endangered species, to list just a very few.  However, 
the scientific method cannot address all questions, and even if it could, most decisions cannot 
wait for all data to be collected.  An examination of what we know and don’t know regarding 
just one species, the Kirtland’s warbler, illustrates not only how such data are gathered and 
analyzed, but also the limits of the data. 
 
Science is often described as a reiterative process, where the results of one application of the 
method lead to incremental steps forward and offer the chance to recheck old ideas and 
conclusions.  The process begins with an observation of some type, gathered from a reading of 
the scientific literature, observations of the world around (such as Newton’s apocryphal but 
illustrative falling apple), or ideas generated from inductive or deductive reasoning.  The idea to 
be tested is stated an hypotheses, or a clear, testable statement of the idea.  Actually the 
hypothesis is stated in a negative way so that it can be refuted.  For example, one would not test 
to see if there was an elephant in a room.  Rather one tests the idea that there is not one.  If one is 
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found, the hypothesis is refuted, but if none is found, one keeps testing or looks for another 
problem because one cannot draw any conclusions from the absence of data.  You cannot prove 
that there is not an elephant in the room simply because you did not see it; the elephant might 
just be better hidden than you think or your means of searching for it was inadequate.  A 
controlled experiment provides the test of the hypothesis, after which one draws conclusions and 
begins the process all over.  Results of experiments are published so that others can review and 
recheck the ideas, methods, and conclusions.  Finally, experiments rarely yield certain results, 
but rather results that are correct within a range of accepted confidences.   
 
Island bird populations have been studied for centuries, and many biologists speculated on what 
determined how many species would occupy these oceanic islands.  An examination of data on 
the diversity of species found on islands in the Pacific lead to biologists, R. H. MacArthur and E. 
O. Wilson to publish their idea called island biogeography, that only two factors determined the 
species richness (or number of species) on an island: 1) The size of the island and 2) the 
proximity of the island to a mainland source of species.  Island biogeography has been a 
fundamental paradigm in biology for over thirty years (Brown and Lomolino 2000, Heaney 
2000).  Originally proposed to explain species richness in island settings (MacArthur and Wilson 
1967), biologists soon applied it to any fragmented habitat where that habitat functioned as an 
island in a sea of other habitat types (Brown 1971, examples include Houle 1990, Mladenoff et 
al. 1993, and Smith et al. 1993).  The theory predicts that only two factors, island colonization 
and local extinctions, determine local biodiversity (species richness) or even species population 
levels based on local immigration and extinction.  Implications from the theory are rather 
straightforward, and include the need to make reserves (habitat islands) 1) as large as possible 
(i.e one 100 ha island is better than two 50 ha islands), and 2) as close to other islands or 
mainland (large areas of contiguous habitat) to allow for species immigration or colonization.  
The theory, supported by numerous experiments (Heaney 2000, Johnson et al. 2000, Saunders et 
al. 1991), predicts that the habitat itself and the species involved are largely not relevant, only 
habitat size and proximity to mainland source populations matter.   
 
Management of critical habitat for species conservation has therefore focused on acquisition of 
large tracts of land for species protection as preferable over smaller, unusual pieces.  To limit the 
fragmenting of forest habitats, scientific and legislative controls have centered on limiting clear 
cutting.  The National Forest Management Act of 1976 generally limits clear cuts to 40 acres 
except under limited circumstances such as the conservation of endangered species.  Early 
analysis of forest cover data that looked at forest changes since early settlement showed forest 
cover shrinking and becoming more fragmented  (Mladenoff et al. 1993, Curtis 1959).  
Numerous studies showed that the effect of these shrinking forest parcels was the loss of 
endangered species (Newmark 1995, Templeton et al. 1990, Johnson et al. 2000).  It seemed 
clear that island biogeography was correct, and its assumptions shape most large-scale 
conservation efforts. 
 
Interestingly, not all recent studies support the paradigm expressed by the theory of island 
biogeography (Brown and Lomolino 2000, Lomolino 2000, Gilbert 1980).  These studies suggest 
reinterpretation of the extant data.  For example, Diamond (1988) quantifies resources in the 
habitat islands to differentiate areas.   Heaney (2000) suggests the equilibrium called for in island 
biogeography is unlikely.   Some call for new methods of evaluation, some provide new data that 
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contradict the reigning paradigm, and some for throwing out the old ideas of island 
biogeography, while at the same time that other biologists are confirming it.  What will emerge 
from this debate?  Doak and Mills (1994) suggest that theory does not always translate to 
concrete actions, and in fact may lead to problems in practical applications.  Probably island 
biogeography will survive, but modified with new experimental results.  However, we may 
witness one of ecology’s greatest paradigm shifts (Brown and Lomolino 2000).   
 
Unfortunately, the implications for species management are very different, depending on the 
classical interpretations of islands compared to the newer, emerging theories (Higgs 1981).  
Under MacArthur and Wilson, a larger island is always better than two smaller islands, assuming 
similar proximities to mainland.  The new interpretations suggest that two 25-km2 islands might 
in fact be better, given the right habitats, than one 100 km2 island.  Which is correct?  And what 
should a biologist trying to protect an endangered species do?  It could be a decade before 
enough data are produced to either reconfirm island biogeography or to modify it.  In the interim, 
we lose species at a rate at least as rapid as the mass extinctions found in the fossil record to 
habitat loss, narrowness of species distribution, and other causes of extinction (Russell et al. 
1998).  Resolution of such conflict in science takes time and lots of experimental data.  In the 
interim, biologists have to continue to monitor and protect endangered species.  Most will use 
island biogeography until it is proven inappropriate trying to maximize the common good 
(Shrader-Frechette 1990), and as such form the basis of the model now used in managing 
Kirtland’s warblers. 
 
Endangered species are typically thought of as located in stable, undisturbed environments and 
have low reproductive rates, long generation times, fixed habitat needs, and high amounts of 
parental care, and are generally highly sensitive to habitat disturbances.  The “poster child” 
endangered species include spotted owls (Strix occidentalis), California condors (Gymnogyps 
californianus), Alaskan caribou (Rangifer tarandus), and Florida panthers (Felis concolor).  
Each thrives in large tracts of relatively undisturbed habitats and is generally protected by 
reserves of wilderness, roadless areas, and old-growth habitats.  Principle human use conflicts 
center around logging, hunting, drilling, or draining, respectively.  In short, the typical protection 
is to limit human access to the habitat in order to allow the species to increase.  However, not all 
endangered species are found in these classic pristine or “unspoiled” habitats.  In fact, biologists 
note that any ecologically specialized species is at risk for extinction (Newmark 1995, Willis 
1974).   
 
Most endangered species management, especially at the federal level, focuses on identification of 
habitat types critical to the successful propagation of the endangered species.  Obviously some 
species protection extends beyond habitat management, including controlling hunting, trade in 
species parts (such as the ivory trade), and the like.  But habitat management remains the primary 
tool in species conservation.  Most endangered species occupy relatively undisturbed habitats 
and those already concerned with the environment tend to find protecting such species easy.  Set 
aside older, pristine, roadless areas and just leave the species alone appeals to many preservation-
minded people. 
 
The Kirtland’s warbler is an unusual endangered species.  Its critical habitat is a highly-disturbed 
but still specialized forest.  Historically fire swept large tracts of northern forests and cleared the 
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land, promoting jack pine forest regeneration.  With settlement and the suppression of fire, clear-
cutting has become the main tool of propagating young jack pines.  Clear cutting, the logging 
practice abhorred by many because of the damage done to old growth forests in the West, when 
applied in the northern hardwood forest, creates areas needed for this endangered warbler.  
 
Studies of population dynamics, or the study of numeric, structural, and distributional changes in 
a population over time yield basic but critical information about how populations are responding 
to their environment.  Numeric changes are changes in the population total, or census of the 
population.  Structural changes refer to changes that affect the age ratios or sex ratios within the 
population.  Distributional changes are those spatial changes that result from geographic 
movements within a populations.  Populations are interacting individuals of the same species.  
Populations increase through births and immigration, and they decrease through deaths and 
emigration.  In short, numeric changes are the result of changes in population structure and 
distribution or: 
 

Nt= (BR – DR) + (IR – ER)  
 
Where Nt is the number of individuals in a population, BR and DR are birth rate and death rate, 
respectively, and IR and ER are the immigration rate and emigration rate.  Changes in Nt are 
numeric changes.  Changes in birth and death rates affect the structure of a population.  The 
migration rates into and out of an area are the distributional effects on a population. 
 
Nt gives the population value for some discrete time “t”.  Population dynamics models 
populations over time.  For populations that add incrementally or discretely without overlapping 
populations, the formula for population growth unfettered by environmental resistance is: 
 

N1 = N0 (1+ r)   
or: 
 

N1 = N0 + rN0 
 
Where “r” is the population rate of increase (additions to the population through births or 
immigration minus losses for deaths and emigration) and N0 and N1 are the population sizes at 
time 0 (or the initial population) and time 1, respectively.  If r is negative, the population is 
decreasing, and if it is positive, the population is increasing.  And the next, or second generation 
would be: 
    
   N2 = N1 + rN1 
 
Over time, this generalizes to: 
 
   Nt = N0 (1 + r) 
 
As time periods for the discrete model decrease, it reduces to a continuous model.  Most 
population models of this unrestrained growth use a continuous model rather than a step-wise or 
discrete model.  The mathematical representation of the continuous model is: 
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   Nt = N0ert 

 

The new factor, e, is the base to natural logarithms (2.71828…).  This unrestrained growth is 
referred to exponential growth, and graphically produces a J-shaped curve of ever-increasing 
populations.  
 
It can also be written as: 
 
   ∆N/∆t = rNt 
 
Where ∆ is the symbol for change, and is a way of symbolizing the differential equation notation 
of dN/dt. 
 
In the real world, such growth curves are not perfectly smooth, and they look like the growth in 
Kirtland’s warblers on non-USFS lands, or areas not on the Huron-Manistee National Forest 
(Figure 6, the generally upper line).  Such growth cannot continue indefinitely as sooner or later 
the population reaches some environmental limit, called the carrying capacity and noted by a 
“K” in formulas.  As the population nears carrying capacity (actually gets half way to K), 
environmental resistance such as increased predation, parasitism, starvation, etc., slows the 
population growth so it levels off at the carrying capacity.  Mathematical models of this growth 
produce an “S” or sigmoid curve, and look much like the population growth for warblers found 
in the Huron-Manistee National Forest (Figure 6, the generally lower line).   
 
Such growth is modeled mathematically in discrete steps as: 
     
   Nt = KN0 / [N0 + (K – N0)e-rt] 
 
As the time steps are decreased, this reduces to: 
 
   ∆N/∆t = rNt(K-Nt/K) 
 
Where ∆ is again the symbol for change or for the differential equitation notation of dN/dt, and 
the portion of the equation in parentheses is referred to as environmental resistance.  It is the new 
addition from the exponential growth shown earlier. 
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Figure 6.  Growth in Kirtland’s warbler populations over time illustrates both 
exponential population growth for the warblers found on areas outside the Huron-
Manistee National Forest (HMNF) and logistic growth for warblers in the HMNF. 

 
While Kirtland’s warblers were first found in Michigan in 1903, the first census did not occur 
until 1950, and the second not again until 1960.  Since 1970 there has been an annual census of 
the species, and good numeric data are available.  The census also locates each singing male, and 
therefore distributional data are available.  Very little work has been done on this warbler’s birth 
and death rates, so little can be inferred about population structure. 
 
Annual population surveys of Kirtland’s warbler provide both numeric and spatial data on 
population trends best evaluated with quantitative tools available on computers.  Similarly, forest 
surveys provide stand age and composition over the entire national forest, which would be too 
complex to effectively evaluate without visualization tools.  Both processes are necessary to 
effectively conserve the warbler species.  But unfortunately alone, they do not reflect the full 
reality of the constraints on warbler management.  There are legislative issues that restrict the 
available options, and complex social and economic issues that further affect what can be done.   
 
The U.S. Forest Service manages national forests under several relevant laws.  The Multiple-Use 
Sustained-Yield Act of 1960 requires that this federal agency mange its lands not just for timber 
production, but also for outdoor recreation, range availability for grazing species, watershed 
management, and for fish and wildlife.  In addition, mineral production was already protected 
under Mining Law of 1872 and again later under the Mining and Minerals Policy Act of 1970.  
Except for mining, these forest resources must be managed for a sustained yield, allowing for 
long-term renewable resource uses.  In other words, resources, except for minerals, cannot be 
removed faster than they are regenerated.  National Forests are use-oriented, unlike our national 
parks or wildlife areas.  The Forest Management Act of 1976 governs the actual administration 
of the forests, requiring a planned effort at multiple use and sustained-yield management, 
including publicly available management plans.  The National Environmental Policy Act of 1969 
(NEPA) set a national policy of productive harmony between people and the environment.  As 
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such, it requires detailed plans that examine the environmental impacts of federal actions, 
including national forest management plans and endangered species recovery plans.  
Specifically, NEPA requires a consideration 5 specific aspects when the federal government 
takes significant action: 1) an examination of the environmental impacts of the proposed action, 
2) any unavoidable adverse environmental effects of the proposed activity, 3) any alternatives to 
the proposed activity, 4) examination of the short-term uses of the environment and the 
relationships to long-term productivity, and 5) and listing any irreversible and irretrievable 
commitments of resources involved in the proposed action.  These plans are public and 
reviewable before final implementation, and the EIS process requires both public input and 
consultation with other federal, state, and local agencies.  
 
Warblers are migratory birds that cross international boundaries, and are covered in part by 
international treaties.  Domestically, the Lacey Act of 1900 and the Lacey Act Amendments of 
1981 prohibit the importation of live or preserved migratory birds and bird parts, among other 
activities, and prohibits possession of live migratory birds or parts in violation of law, so 
Kirtland’s warblers themselves are protected.  Declared endangered by an act of congress under 
the Endangered Species Act of 1973, the warblers are further protected from habitat loss or other 
direct or indirect adverse activities done with federal dollars or by federal agencies.  That act also 
required the production of a species recovery plan, first completed in 1976 for Kirtland’s 
warbler.  In that document, critical habitat was identified and habitat creation goals were set.  In 
addition, other practices such as closing nesting habitat to public uses were first indicated.  
However, public acceptance of such closings to recreational uses has been far from universal. 
 
Another way of framing this species conservation problem would be to note that the as part of its 
meeting requirements of federal laws for well-managed forest lands available for multiple uses, 
the U.S. Forest Service hires scientists to provide data to inform its management plans.  The 
scientists use the scientific method and the best available information from the scientific 
community to evaluate and conserve species such as Kirtland’s warbler.  Those data are used by 
managers under the legal and social constraints to make recommendations and enact plans that 
conserve endangered species, balanced against other goals including recreational uses.   
 
The data can be quite voluminous.  There are data on the locations and numbers of singing males 
for the last 50 years.  There are forest stand data that go back over a century to the earliest land 
surveys.  Short of spatial analysis, there is no way to evaluate the relationship between the 
warbler populations and their habitats.  Fortunately computers and relevant software provide 
ways of effectively visualizing and analyzing the large data sets.   
 
Spreadsheets such as Excel provide an easy way of examining the numerical data on warbler 
populations.  Geographic Information Systems (GIS) allow spatial analysis of complex data sets.  
Unfortunately, most high-end GIS analysis requires expensive hardware and software 
investments, and may hours of specific training.  One leading GIS company, ESRI, makes one of 
the most complex software programs ever produced, ArcGIS.  One version of that, ArcExplorer, 
allows reading of spatial data and limited analysis, is easy to use, and free as a download.  The 
data layers supplied with this module will be used with ArcExplorer, but anyone with ArcGIS 
already available to them can use that software for more sophisticated analysis like that provided 
in this module. 
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Conceptual Model for Problem Analysis:  
 
In this module, we will examine the scientific data related to Kirtland’s warbler populations, both 
numerical and distributional, and the habitats available.  Students, working first alone, then with 
a partner, will evaluate current population trends and set target goals for Kirtland’s warbler 
populations. They will examine habitats available for management, and in small groups make 
specific recommendations based on the biological aspects of the warbler populations.  Next they 
will evaluate the effects of warbler management on forest fragmentation and on other forest 
resources, and reevaluate the biologically-based recommendations in light of the forest 
constraints.  Finally, they will present their proposed plan of action in an abbreviated 
environmental impact statement format (EIS).   
 
There are three models used in this module, one numerical and the other two spatial.  The 
numerical model is derived from the basic Lotka-Voltera model of population growth ∆N/∆t = 
rN((K-N)/K).  The spatial models examine the distribution of Kirtland’s warblers relative to 
habitat types.  One briefly tests how island biogeography predicts warbler distribution.  The other 
is a spatial model of habitat management.  Specifically, warbler numbers are directly correlated 
with the quantity of jack pine forests aged 5 to 15 years in relative proximity to source 
populations.  The environmental resistance in the Lotka-Voltera equation (K-N)/K is the lack of 
unoccupied available habitat.    
 
The model assumes that given constant efforts at other activities such as cowbird population 
controls, increases in Kirtland’s warbler populations come directly from increases in jack pine 
plantations with a 5 year delay and a 20 year cap.  Like any abstraction of the real world, it 
overly simplifies the problem, but provides an ability to actually do something.  Students will 
also evaluate if doing something is better than nothing. 
 
Solution methodology/implementation: 
 
These are discussed in the problems themselves. 
 
Assessment of Model 
 
Model assessment is discussed in Exercises 1 and 2. 
 
Empirical Data: 
 
Data provided include : 
� Numerical Kirtland warbler population data from 1950 to 2003 including details about 

the locations of those warblers at large scale regional categories (All KW Census 
Data.xls) 

� Spatial data on one year of Kirtland’s warbler distributions from 1993, 10 years old to 
provide some degree of protection for current populations to use as current populations 
(93males.shp) 
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� Spatial data on KW significant forest types and ages grouped by forest management 
compartments (esshab.shp) 

� Spatial data on roads in the study area (roads.shp) 
� Spatial data on land ownership within the study area (ownership.shp) 
� Spatial data on recreational trails in the study area (trails.shp) 
� Spatial data on rivers and streams in the study area (waterbody.shp) 
� Spatial data for the Huron-Manistee National Forest Boundary (hm_forest_bndry.shp) 
� Spatial data on the public land survey sections for the study area (sections.shp) 

Data were provided courtesy of Philip W. Huber, District Wildlife Biologist and member of the 
Kirtland’s Warbler Recovery Team, Mio Ranger District, Huron-Manistee National Forest, U.S. 
Forest Service, except for the Michigan and Michigan Counties layers, which were supplied by 
ESRI.   
 
Conceptual Questions: 
 
The model to be developed, like any mathematical abstraction of the real world, makes some 
assumptions that may not accurately reflect reality.  What are some of these? How much do 
societal impacts, such as reduced recreational opportunities during the nesting season, outweigh 
the impacts of biological processes like increased nesting from new habitat?  How important is 
island size and island proximity for Kirtland’s warbler colonization, and does some proximity 
factor need to be included in the habitat model? 
 
Problems and Projects: 
 
Exercise 1: 
 
Problem: The first step to understanding a species status requires reliable numerical data.  
Annual censuses of the warbler’s entire range since 1970, and twice before that in 1960 and 
1950, provide data about the status of Kirtland’s warbler.   
 
Objective: For the first exercise, students will convert tabular data into graphs for improved 
visualization and comprehension.  Students will also understand changes in Kirtland’s warbler 
populations and draw conclusions about which conditions promote warbler populations.   
 

� Open the Excel spreadsheet named “All KW Census Results” found in the Model Data 
folder.  In general, it is fruitful to explore the data you have available to you before using 
it.  This exercise will guide you in reviewing the data, understanding what is known and 
what is not known about numerical responses of the study species, and provide practice 
drawing conclusions about the data. 

 
� Note that there are five worksheets in this one spreadsheet, shown with separate tabs at 

the bottom of the spreadsheet.  Four of these have specific types of data excised from the 
overall source labeled “Source Data.”  Here each column of data will be described.  Refer 
back to this description as needed when you move on to the thematic worksheets.  Since 
the later worksheets are simply subsets of the original source data, anything that applies 
to the source data applies to them.  Note that all census numbers represent the number of 
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singing males located, and the assumption is that for each breeding male there is one 
breeding female.  Column headings occupy the first row of the spreadsheet, and moving 
from left to right are: 
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Year: The year in which the census data were collected 
HMNF: The warblers found within the boundaries of the Huron-Manistee National Forest 
Mack Lake Burn: The number of HMNF found within the well-studied large wildfire area of 

Mack Lake 
Lower Peninsula: The number of warblers found in Michigan’s lower peninsula, whether or 

not inside the national forest.  HMNF is a subset of this. 
Upper Peninsula: The number of warblers located in Michigan’s upper peninsula 
Singing Males – Michigan: The total number of Kirtland’s warblers in Michigan, usually the 

entire species count, and a sum of Upper Peninsula and Lower Peninsula 
Wisconsin: Number of Kirtland’s warblers located in Wisconsin for that year of the census 
Ontario: Number of Kirtland’s warblers located in Ontario for that year of the census 
Wildfire: Number of warblers from any region found on jack pine habitat started by wildfire.  

Note that the data do not cover a long period of time 
Plantation: Number of warblers from any region found on jack pine habitat initiated by 

prescribed logging and jack pine planting 
Other: Number of warblers in jack pine habitat of origins other than plantation and wildfire. 

 
 
� Just by looking at this one worksheet, without consulting the other worksheets or making 

any graphs or doing any calculations, what conclusions can you make about the trends in 
warbler populations?  Which regions are showing changes in warbler numbers over the 
last 50 years? What role does fire play in warbler numbers?  What are the advantages and 
disadvantages of tabular data such as these? 

 
� Clearly there must be a better way to approach the data, and Excel provides many 

options.  Separating the data into thematic worksheets, done for you already, allows some 
trends to become more apparent.  Move to the worksheet “Overall Numbers” by selecting 
the tab at the bottom of the worksheet with that name.  You should see something close to 
the following, although the exact buttons on the menu bar at the top vary based on the 
user’s spreadsheet environment.  Under the colored bar that identifies the spreadsheet in 
use is a command bar with word menus.  Under that are icons or buttons for the most 
commonly used commands. 

  

 
 

� Look at the data for overall numbers.  These came from combining data from several 
other columns together in one place and give the total numeric values for the species.  
While scrolling up and down the spreadsheet allows some sense of the trends, most 
people find graphitic images to be more useful.  Excel greatly simplifies graph making.  
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Here one graph will be developed and you will use the same techniques to explore the 
rest of the data on the other worksheets.  In the end, remember that not only must the 
finished graph convey information to you now, it needs to contain other information, 
such as labels and a title, so that when you refer to it later it will still be useful.     

 
� Under the command bar heading “Insert” (fourth from left after “File,” “Edit,” and 

“View”) choose “Chart” OR choose the chart function button (it looks like a bar graph 
with blue, yellow, and red bars).  The Chart Wizard will open.  For now, choose the XY 
Scatter chart that will connect the data points with a smooth line, but still show the actual 
data points, as indicated below.  Then press “Next.” 

 
  

 
 

� The second step of the Chart Wizard allows you to select the data you wish to graph.  
Select “data series in columns.”  There is an empty box called “Data Range” which you 
will select.  Press the small box at the right of the data range box (indicated by the arrow 
below), which will allow you to select the data you want. 
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� It will then shrink out of the way but still be visible on the screen and you can use your 
mouse to highlight the data of interest, here both columns A and B (“Year” and “Singing 
Males- Michigan”).  If you select the columns themselves (the A and the B) you will 
select all of the data in the series to the bottom of the columns.  If you only wanted to 
graph the years 1980 to 1990 you could select just those.  Once you have highlighted the 
columns (a dashed box appears around them), locate the data range box on the screen and 
once again click on the small box at its right as you did before.  Note that had you 
selected the columns before choosing Insert-Chart or opening the Chart Wizard, this step 
would be done for you automatically.  It is useful to know both ways of getting data into 
a chart. 

 
� You should now see a preview as below.  The chart is almost ready, but needs some 

refinements from the default settings.  Click on the button marked “Next”: 
 
 

 
 

� Wizard Chart 3 allows additions of titles and legends.  The default title and axis legends 
may be adequate here, but later you will want to be able to change these.  For now, accept 
the defaults and click “Next” again. 

 
� Wizard Chart 4 allows you to select where you would like the graph placed.  For now, 

keep it as an object in this worksheet (the second option and the default) and click 
“Finish.” 

 
� You should now have a graph of the overall numbers of Kirtland’s warblers, shown 

earlier in the background text as Figure 4.  You can select the whole graph and paste it in 
a word-processing document or as a figure in a presentation software package, which will 
be useful later.  You can also select any part of the graph and modify it.  For example, 
selecting the title brings up a title editing menu.  Select the graphic element you want to 
edit (left mouse click) and then a right mouse click and choose the function of interest 
such as “Format Axis.”  Under the tab for “Scale” you can select maximum and 
minimum allowable ranges.  If you make a mistake, you can always select the undo 
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function from the Edit command bar for the spreadsheet (or the Undo button which 
appears as a counterclockwise rotating arrow). 

 
� While detailing the elements of making effective graphics is outside the realm of this 

exercise, some basic points are worth noting.  First, an effective title and data labels will 
help others understand the figure.  Nonsensical values, such as negative years or 
population numbers below zero are impossible, but Excel cannot determine that 
automatically, so you need to edit the data ranges.  Select the data axis and bring up the 
context menu and set the minimum Y-values to zero, and the minimum X-value to 1950, 
the first year for which you have data. 

 

 
 

� Also note that even the selection of the chart type at the beginning may not be an obvious 
choice.  Since lines connecting the data points imply a direct relationship from one data 
point to the next, some would prefer a scatter plot without the connecting lines.  Pie 
charts of the data would reveal other important information, especially in later 
worksheets.  Here the connecting lines are not unreasonable, but that will not always be 
the case.  If time allows, you should return to that step and try other chart types to see 
what they can illustrate. 

 
� Look at the graph you made and answer several questions.  First, what does the graph 

show that the table did not (and what does the table show that the graph does not)?  
Secondly, what do the data mean, or what trends do you see including what type of 
numerical population growth you observe?  Here, the numbers of Kirtland’s warblers is 
obviously increasing.  What is happening to the rate of change (is the slope of the line 
getting steeper or shallower)? 

 
� Now move on to the next worksheet “By Region.”  First look at the data.  Not all 

locations or years have data.  For example, the numbers for the Huron-Manistee National 
Forest were not recorded in 1951 and 1961.  Do you observe any trends in the tabular 
data? 

 
� Make a graph of the data as you did for the last worksheet.  Here, however, when you 

select the data range, select all of the columns (A through H).  When you generate the 
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default graph, each column is displayed as a series in the legend box in the order it was 
read from worksheet.  It is important that you edit those series names to be the 
appropriate column labels for the data if you do not use the column headings.  Also recall 
that if you select the columns before choosing the function of Insert>Chart, the chart will 
default to inserting what you selected.   

 
� An interesting trend becomes apparent once this graph is produced.  While overall 

warbler numbers continue to rise, what is happening to the numbers on the Huron-
Manistee National Forest?  What kind of numerical population growth does this 
illustrate?  Are there areas of both types of population growth? What kind of 
environmental resistance might be responsible for this? What other trends can you 
determine?  Why do areas near the source populations in the Lower Peninsula rise rapidly 
while those elsewhere only occasionally have birds, and then only for a year or two 
before they are no longer found there? (Recall the principles of island biogeography) 

 
� Now examine the role of fire in producing viable Kirtland’s warbler habitat.  The 

worksheet “Fire vs Logging” gives the total number of warblers, and where data exist, 
what type of jack pine habitat they occupy.  What trend do you observe here?  What can 
you conclude from that? 

 
� It is important to understand how the value of the habitat changes over time.  An 

examination of the area burned around Mack Lake, Michigan, in 1980 and the subsequent 
colonization of the habitat by Kirtland’s warbler immigrants clearly illustrates the 
ephemeral nature of the warbler’s use of jack pine areas.  Colonization and use of jack 
pine plantations follows the same overall use pattern.  Graph the data from the “Mack 
Lake” worksheet.  Recall that the fire occurred in the summer of 1980, so the age of the 
jack pines is simply the number of years after 1980.  When does the habitat first become 
usable to Kirtland’s warblers, what are the optimum number of years after fire and 
cutting, and when is the habitat no longer used by the warblers?  In what year will the 
jack pines be large enough to harvest commercially and recreate suitable warbler habitat? 

 
�  Finally, test the validity of the population growth models against the actual data.  You 

will need to solve the population growth models for the Huron-Manistee National Forest.  
The two formulas needed are (Nt = N0ert) and (Nt = KN0 / [N0 + (K – N0)e-rt]) for the 
periods where the HMNF Kirtland’s warblers were undergoing exponential and logistic 
growth, respectively.  You can actually use the later for either time, and we’ll apply data 
to it to validate the mathematical model.  We know that K for HMNF is roughly 375 
singing males from the data in the spreadsheet used in exercise 1. We can choose a 
population for two successive years and see how well it works.  For illustrative purposes, 
consider 1998 and 1999 where the number of singing males is 337 and 372 
consecutively.  Do you expect r to be positive or negative (if the population is below K, it 
should grow to K, and if it exceeded K, it should decline)?  Use the first number in the 
formula (here you must use the logistic growth formula as we are near carrying capacity) 
and calculate an r value for near carrying capacity.  Then apply it to other near-by data 
points.  If we try 372=[(375*337)/[337 + (375-337)er(1)]] and solve for r, we get r = 
0.0988.  That is positive, but low, which you’d expect near K.  Now if we choose another 
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starting number from the same area of the population growth chart, we should get similar 
results.  Where the population growth differs from what we calculated, such as during the 
period of exponential growth, we would need to calculate a new r value.  Try the 
population values for 1988 and 1989.  (You should get r = 0.1149.)  If you use the 
formula for exponential growth you get r = 0.2136.  Which is correct?  Why is there a 
difference? (Both are models, and as such are abstractions of the real world.  What are the 
differences in the equations?  Are any of the numbers in either formula more subjective 
and therefore potentially in error?) The mathematically inclined can solve for r (or 
program Excel to calculate r) for any interval and test how closely the HMNF warbler 
population mimics pure logistic growth. 

 
� With a partner, discuss the following.  Be prepared to uses graphs or tabular data to 

support your answers, except for the last question.  
• Where are most of the new Kirtland’s warbler populations located?  Are they on 

National Forest land?  Were they in the past? 
• What is the role fire is playing in the increasing Kirtland’s warbler populations?   
• What can you conclude about the success of habitat management in increasing 

populations of Kirtland’s warblers? 
• What limits the ability to create more Kirtland’s warbler habitat?  Here you 

should discuss not just biological limitations, but speculate on economic and 
social limitations.  

• Does the proposed model seem reasonable, that habitat modification (jack pine 
plantations) account for the growth in Kirtland’s warbler populations)? 

• How much should we spend on conserving any given species?  If so, what do you 
do when conserving one endangered species threatens other endangered species? 

• Finally, should we preserve species such as Kirtland’s warbler? 
 

� With your partner, create a document that address the above questions in a few sentences 
each, illustrated with a graph copied from the spreadsheet and inserted into the text where 
appropriate.  The outcome should be a brief text with several graphs, depending on which 
ones you think are most useful in illustrating your points.  Be sure to save a copy of this 
document in electronic form as the material will be used again in a later exercise. 

 
Exercise 2: 
 
Problem: In addition to understanding the numerical aspects of any population, particularly an 
endangered species, an examination of the spatial or distributional aspects of a population can 
yield important information.  For Kirtland’s warblers, an understanding of where the birds are 
nesting (which habitats they are actually occupying) relative to other available habitat or 
potential habitat conflicts is essential.  Recall that the simple model of population growth we 
developed in exercise one is that habitat limitations provide the environmental resistance that 
slows population growth from an exponential growth observed earlier on the HMNF (from the 
mid 1980s to the mid 1990s to an apparent carrying capacity of just under 400 singing males. 
 
Objective: This exercise examines the spatial aspects of the population of Kirtland’s warblers 
found on the Huron National Forest in Lower Michigan.  Students will learn to approach spatial 
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problems and to use a geographic information system in spatial analysis.  Students will identify 
habitat islands and identify non occupied but available habitat.  A final output of a map of 
available habitat will be produced. 
 

� Open ArcExplorer.  The blank workspace should look as follows: 
 

 
 

� The command bar has the usual Windows command categories such as “File,” “Edit,” 
“View,” “Tools,” and “Help,” and one additional called “Layer.”  A geographic 
information system, at its most basic, is a means of layering maps onto each other.  The 
white space at the right will be used for drawing the maps, and the gray column at left is 
for map layer management.  First you will add two layers, or maps, and work with them 
to increase familiarity with the software.  Then you will add useful background layers 
including roads, trails, and lakes.  Finally you will add spatial forest data to those layers 
for the next analysis.  Four command icons are currently visible (colored) and they are 
shortcuts to using the text command bars of “File>Open Project,” “Layer>Add Layers,” 
“Layer>Geography Network,” and “File>Print.”  Either click on the colored icon for 
“add layers” or choose “Layer>Add Layers.”   

 
� Navigate to where your data files are stored (Keck Module Island Biogeography>Model 

Data>GIS Layers) and add “Michigan” and then “Michigan_Counties” (and add only 
these two layers for now).  Make sure “Shapefiles” is the option in the search window.  
When you locate the layer file “Michigan,” double click on it.  Then add 
“Michigan_Counties” using the same methods and close the “Add Layers” dialog box.  
You should see this (don’t worry yet about which layer is listed first): 
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� Note that more icons have become available on the command icon row, but no maps are 
as yet displayed in the large white area.  Click on the gray box to the left of the layer 
name “Michigan” for the Michigan layer; a check mark should appear.  A solid colored 
map of Michigan should appear in the large white area.  Do the same for 
“Michigan_Counties”.  If “Michigan_Counties” is the layer listed above “Michigan,” as 
above, then you will see the counties of Michigan appear.  If “Michigan_Counties” is 
beneath the “Michigan” layer, you will see no change.   

 
� The stacking of layers gives the order in which they appear on the screen, with whichever 

layer is listed first at left as the top-most layer displayed.  You can change the order by 
selecting the layer (left click once – only once! – on the layer name), and then as a 
separate action left click on the now-highlighted layer making it the active layer.  While 
still holding the left mouse button down, drag the layer above or below the other.  You 
cannot just double click on the layer or a “Properties” dialog box will open. If it does, 
close it.  Try moving the two layers few times until you can easily move a layer up or 
down, ending with the “Michigan_Counties”  above “Michigan.”  It is important to 
remember that most map functions occur to the active layer, which is the one highlighted 
in a box in the left column.   

 
� The color of the state layer is shown under the name of the layer in a box.  You will make 

that yellow for easy display purposes.  If you choose a color other than yellow because 
yellow is not an effective color for you, simply use that color name wherever “yellow” 
appears in the next few steps below.  Double click on the layer name “Michigan” and a 
“Properties” dialog box will open that looks like this: 

 

 
 

� Make sure the style is “Solid fill” and for color, choose yellow (use the dwon arrow in the 
color box to see other color choices).  Then pick “OK.”  The small box in the “Michigan” 
layer should now appear yellow, but nothing else on your map should have changed if 
you have the “Michigan” layer underneath the “Michigan_Counties” layer, because the 
top layer covers and conceals the lower layer.  Open the properties box for the 
“Michigan_Counties” layer, and for color choose “blue,” and then for style choose 
“Transparent fill” and then “OK.”  Your Michigan map should look yellow, not blue.  
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This is because you choose “transparent” for the counties layer, so only the outline of 
shapes was retained, allowing the yellow “Michigan” layer underneath to show through.   

 
� Now you will make each county appear in a different color, which will hide or obscure 

the “Michigan” layer beneath the counties.  Open the “Properties” box for the 
“Michigan_Counties” layer again.  Note that the first box had a “Draw features using…” 
with “One Symbol” chosen.  Change that to “Unique symbols” and note how the 
properties box changes.  In the now-available “Field for values” choose “NAME”.  Each 
field is a column in the data for this layer, and the “NAME” field, or column, gives the 
county name for the county associated with that name.  Make sure the color scheme is 
“random” and the style is “solid fill.” Click “OK.”  The counties should all display a 
different color, and their unique names show up in the county layer box at the left of the 
map in the gray area.  Besides producing a colorful map, this illustrates how the GIS can 
display different data for a layer, depending on what you want displayed. 

 
� Each map layer has data associated with it in a table stored with the map.  Each field in 

that table is like a column in an Excel worksheet.  Each row is a unique map entity, here a 
county.  Map entities can be points with no length or width (like a bird’s individual 
location, a building, or other feature you might draw as one point or location).  Entities 
can also be lines with length but no width (like a road or a river), or they can be polygons 
(shapes with length and width).  Here the counties are polygons.  The real value of this 
kind of arrangement will become clearer as you work through the exercise. 

 
� Here you will add labels to the counties.  Reopen the “Properties” dialog box for 

“Michigan_Counties” and click on the tab for “Labels.”  For the first box “Label features 
using” choose “Name” again, and click on “OK.”  The county names should be visible on 
the map, but they are far larger than the space available allows to be functional.  One of 
the icons underneath the line commands at the top of the screen is a magnifying lens with 
a “+” in the middle.  Click on it, and note that your cursor on the screen now looks like a 
magnifying lens.  You can draw a box around an area (left click and hold the left button 
down and move the cursor, you’ll see a box appear) and enlarge the area in the box.  The 
labels stay the same size, but as you enlarge the map, they look more appropriate.  Labels 
are a useful way to keep track of what you are viewing, but can be cluttering if you 
display too many.  To the right of the magnifying lens is one for moving outward, or de-
magnifying.  To the left of the lens you are using is one for zooming to the active 
(highlighted) layer (currently “Michigan_Counties”) and the one to the left of that zooms 
you out to the extent of your largest layer.  Here both layers are the same size, so there is 
no difference. 

 
� One of the most useful tools in the toolbar is the “i” with the black circle around it.  It 

stands for “identify” and allows you to view the data fields associated with whatever you 
point at.  Choose it, and click on a county on the map (making sure that 
“Michigan_Counties” and not “Michigan” is the active layer selected off to the left).  The 
identify tool lets you view the row of data associated with what you pointed at.  To see 
the whole data table, you’ll need to build a query, which you will do shortly.  You can 
pan around the map using the hand button, to grab and move the map, and the pan button 
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(a hand with four blue arrows on it).  Maneuver around the map until you are comfortable 
zooming in and out, panning, and returning to the full map extent.  Then remove the map 
labels and make the counties transparent again (Map properties>one symbol and 
transparent fill).  You should have a yellow “Michigan” layer under a transparent 
“Michigan_Counties” layer as you did earlier.  If you have that but cannot see the 
counties themselves, reopen the counties property dialog box and make sure that you do 
not have a check mark in the “Remove Outline” box.  The outlines are the county 
boundaries, and they should be “solid line, black, width 1” for now. 

 
� Choose the “add layer button” (or Layer>Add Layers) and add “Trails”, making sure it is 

the top-most layer.  Again, you can move a layer by dragging it up or by right clicking on 
the layer and choosing “move layer” and then the choice here of “move to top.”  Check 
the gray box to the left of the layer name “Trails” to display it, and click on the layer 
name to make sure it is the highlighted or active layer.  Now choose the “zoom to active 
layer” button (it has the magnifying lens and one layer shown in red).  The map should 
zoom in to a trail network in the Kirtland’s warbler study area.  If you want to see where 
that is relative to Michigan, zoom out to the full extent and look for the trail network in 
the northeast portion of the Lower Peninsula. 

 
� Bring up the “Trails” layer map “Properties” box.  For symbols, choose “unique 

symbols”.  For “field for values” choose “Type” (you have to scroll down to it; type 
refers to the type of trail it is).  For labels (under the labels tab) also choose “type” and 
look at the map.  You are displaying the trail type, or the kind of trail each line 
represents.  The trails are colored by type, and labeled (more become visible as you zoom 
in,) but you can also use the “identify” tool to see what different trail types are.  Note also 
that the color key appears automatically under the layer name in the far left of the 
display.  If you wanted to highlight a certain trail type, you could do that by reopening 
the layer properties box, choosing the specific type you’d like to highlight (such as ATV), 
choosing a unique color for it, and pressing “OK” to make that trail type appear in the 
new color.  While useful, often what you want to do is actually calculate some basic 
statistics on the feature.  You’ll do that next. 

 
� Choose the “Query Builder” (the icon by the binoculars with the red question mark or 

choose “Tools>Query Builder.”  You should see a dialog box that looks like: 
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� Click once on the field “Type” (you’ll have to scroll down for it) in the “Select a field” 
box, then the equals “=” button from the mathematical functions in the center, and then 
choose “ATV” from the values (which shows only legitimate choices for that particular 
field type).  You should see the arithmetic expression “Type =  ‘ATV’” in the long 
horizontal box above the “Execute” and “Clear” buttons. Click on “Execute” and you 
should see this:   

 

 
 

� Press the “Statistics” button at the bottom, and choose “Length” as the field to get 
statistics on, so you can determine how many feet of ATV trails there are.  A statistics 
dialog box appears that indicates that there are 266 trails segments (not discrete routes), 
along with the longest segment (more an artifact of how the data were recorded) but with 
the total length of all ATV segments combined, or total trail length for ATVs of 
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2,843,376 feet or 538 miles of ATV trail on the display, with a small portion of the trails 
outside the eastern boundary of the national forest.  Much of the functionality of GIS 
comes from the ability to query data in this fashion.  Also note that knowing what each 
field represents is useful, but many of them have value only to the builder of the layer.  
These exercises focus on the field to use for analyzing habitat for Kirtland’s warblers and 
determining potential human-use conflicts. 

 
� Using the techniques shown in the earlier steps, add the following layers and maneuver 

them so they are stacked in the following order: “roads,” “trails,” “waterbody,” 
“hm_forest_bndy,” “sections,” “ownership,” Michigan_counties,” and “Michigan.” Turn 
off “trails,” “Michigan,” and “Michigan_Counties” for now.  Make your roads all red, the 
watercourses and Ausable (for Ausable River) blue, make the sections transparent, and 
make the ownership green (since it will soon display USFS land ownership in the study 
area.  The “roads” layer shows the roads (paved and unpaved) in the study area, 
“watercourses” shows streams as lines and “Ausable” shows that river as a polygon, not a 
line because it is large enough to warrant recording its width.  “Sections” shows the one-
mile-by-one-mile squares of the public land survey, which provide a relatively easy scale 
for visual reference.  “Ownership” contains information that will show which lands are 
owned by the USFS.  Note that although the National Forest Boundaries are large, there 
are many tracts of privately-owned land within the forest.   

 
� Activate the “ownership” layer and open the properties dialog box.  Choose “unique 

symbols” and choose “Class” setting “USFS” to green (click on the color box for USFS) 
and both other classes to white.   Recognize that as a USFS biologist, you can only 
manage lands owned by USFS for Kirtland’s warbler habitat.  Now zoom out to the 
extent of the ownership layer and see how much land that is. 

 
� So far you have used GIS primarily to display information in ways you might with single 

maps, such as a map of trails, or a map of USFS-owned land.  As you continue to add 
layers, you need to maintain some degree of organization, both with how the layers are 
stacked, and as to which you choose to display.  For this exercise, the instructions will be 
more explicit about what to display or what task to try, but you should feel free to 
experiment with the software, as some degree of comfort with the process of adding, 
displaying, and manipulating layers will be important for Exercise 3.  If you need to 
interrupt your work, save the file (it will actually be saved as a project, which is a group 
of associated files).  You can later reopen that with “Files>open project”. 

 
� Turn off all layers but the forest boundary and zoom in or out so that just that layer fills 

the screen (recall the button that does this for the active layer, so make the forest 
boundary the active layer.)  Then zoom in on just the Huron, or eastern portion of the 
national forest.  In fact, for the rest of this exercise, roads, trails, and waterbodys have no 
relevance.  You will need them in exercise 3, and leaving them here but turned off will 
make that exercise a little easier.   

 
� Add the layer called “esshab” and turn it on so that is displays against the forest 

boundary.  This is the habitat suitable to Kirtland’s warblers.  It should look like this: 
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� Each area of this essential habitat is in effect a habitat island for Kirtland’s warblers.  The 
Mack Lake burn area, indicated by the arrow, is the main source of Kirtland’s warblers 
for this exercise, is the mainland.  (Note that the warbler data that you will add shortly is 
from 1993, when the Mack Lake burn supported nearly 300 warblers).  Based on the two 
factors that affect numbers on adjacent islands (proximity and size), what would you 
predict the relative warbler numbers would be on each of the 14 habitat islands?  Recall 
that species richness of other species should follow a similar pattern.  Note that in essence 
you are testing the model of island biogeography as it applies to one-species abundance.  
Take a few minutes to realy think through the relative warbler numbers. 

 
� Now add the layer “93males” and turn it on.  How does the actual distribution of 

Kirtland’s warbler compare to what you predicted?  Does it still fit the general trend of 
island biogeography?  You may need to zoom in to areas to see discrete bird points. 

 
� Turn on the ownership layer and turn off the essential habitat layer.  Are any warblers 

found on non-USFS owned land?  Turn esshab back on, and note that no data exist for 
land not owned by the USFS.  What seems likely about the habitat types of areas 
completely in the essential habitat islands, but not owned by the USFS? 
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� Zoom in on one of the larger habitat islands.  Note that each has many polygons in it.  
Each is a forest habitat type, showing how diverse but fragmented even large areas of 
similar habitat type are.  All of these essential habitat types are some form of jack pine 
forest.  If you use the identify button and select one of the small polygons, you’ll see 
many fields of data.  “Year” gives when the stand started, and many near Mack Lake will 
be 1980, and FT gives a two-digit code for forest type.  Two common ones will be 01, 
which is jack pine, and 48, which is jack pine and scrub oak.  “DBH” gives the diameter 
of the average trees in inches at 4 ½ feet above the ground.  This should help you 
visualize the size of the tree trunks.  Look around with the “identify” tool, and you will 
find some old stands started in the 1920s, some that are from the 19th century, and some 
new stands started in 2001.  You can find these quickly using the query builder and 
selecting for year < 1900 or > 2000, depending on what you want to locate.  Since the 
warbler locations are from 1993, and the warblers prefer stands 5 to 15 years old, stands 
started between 1978 and 1988 make ideal habitat, and is where most of these warblers 
are located.   

 
Forest Type (FT) Codes for esshab 
01 jack pine 
02 red pine 
03 white pine 
11 balsam fir/aspen/paper birch 
18 mixed conifer swamp 
48 jack pine/oak 
49 red pine/oak 
53 black oak 
55 northern red oak 
59 mixed oak 
83 black cherry/white ash/yellow poplar 
91 quaking aspen 
93 big tooth aspen 
95 aspen/white spruce/balsam fir 
97 lowland brush 
99 open 

 
� To highlight these specific habitats, make esshab the active layer.  Then choose the query 

builder (the button with the red question mark). Enter the entire query expression of 
(YEAR > 1977 and YEAR < 1989).  Then “execute” and close the query builder.  Almost 
all warblers will be in areas now selected, showing most of them to be in ideal habitat.  
You can use the “identify” tool to examine those outside ideal areas.  How far outside of 
ideal is their habitat?  (It turns out that those are generally areas logged very recently, and 
are an artifact of using older warbler data.)   

 
� Now use the query builder to find habitats that are older than 50 years and can be logged 

soon for warblers (you can use what is now over 50 years old and hence available, or 
what was over 50 years old in 1993 when these warblers were around).  The point is to 
try another query, and to see how much cuttable forest there is.  Be sure to clear the first 
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selection before starting another.  Do this by choosing Layer>Clear all selections from 
the command line.  There are still a lot of areas that can be cut to make additional habitat, 
which would increase the carrying capacity for warblers.  In effect, if you wanted to 
maximize for warblers, you would cut 2% of the available warbler habitat in any given 
year.  Under such a pattern, there would never be any jack pine stands greater than 50 
years old.  Since there are, the carrying capacity for warblers could be increased.  But at 
the cost of never having older forests of jack pine. 

 
� There are just two more GIS skills you will need for the next exercise.  The last step will 

be producing some output.  First you need to learn how to buffer an area.  Turn off all 
map layers except “93males,” “trails” and “esshab”.  Make the warblers layer the active 
layer, and clear all previous selections.  In order to use the buffer feature, you need to be 
sure that the map units are correct or the calculations will be off.  Click the View>Scale 
Properties>Map usnits, and make sure “feet” is selected.  Then use the query builder to 
select all of the warblers (so KWMALES_ID >= the first id number or KWMALES_ID 
<= the last id number.  As you enter the formula, you’ll select the field of 
KWMALES_ID and it will ask if you  want all of them displayed, choose yes.  Then 
enter the equal to or greater than choice (>=), and then select the lowest ID number).  
Close the query builder.  All of the warblers should be selected.  Now choose the buffer 
button (the second from the right, it shows the selection color and some grid lines).  You 
are going to create a means of selecting something close to the warblers, here trails that 
run within 100 feet of the bird locations.  Presumably disturbances along the trail or 
people leaving the trails could disturb the warblers.  You will use the selected warblers 
(all of them) to select trail segments that are within 100 feet of one of the warblers.  Make 
the buffer window look like below and choose “OK”.  Allow some time for this 
processing, especially on slower computers.   
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� You have now selected trails near warblers, and can zoom, pan, and use the identify tool 
(if the trail layer is selected as the active layer) to determine what trail types are near the 
warblers.  Are you more concerned about foot traffic or motorized traffic? 

 
� Finally, clear all of your selections.  The output needed to test the carrying capacity 

model is a printout of a map that shows habitat over 50 years old that can be cut.  Turn on 
layers needed to show warbler use of essential habitats, with the forest boundary and 
whatever other layers you think make the map effective to show the spatial distribution of 
Kirtland’s warblers in 1993.  Select habitats older than 50 years and display them.  Under 
File>Print set up a printout of the map and print out what you are displaying.  Note that if 
you use the Ctrl+PrtSc (control print screen) you save a graphic image of the display that 
can be pasted directly into a Windows document.   Then clear all of your selections and 
produce a map showing the currently available habitat in 1993 relative to the warbler 
positions, selecting for stands started between 1978 and 1988.   This is exactly what you 
did earlier.  Comparing the two printouts, what would you expect the distribution of 
warblers to be in future decades? 

 
� Clear any selections and save the project for use in the next exercise.  You should be able 

to answer the following: 
o What types of habitats do Kirtland’s warbler need for nesting?   
o Where are these habitats distributed? 
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o Are the warblers using the entire available habitat? 
o Are there areas that can be cut to make them age-appropriate for the warblers? 
o How are the habitat islands distributed within the national forest? 
o Are these habitat islands uniform, or broken into smaller patches? 
o With the central island where the Mack Lake fire occurred aging, warblers will 

have to emigrate to other areas.  Where do you expect that to be? 
o Are there potential conflicts of human uses and warbler nesting areas?  

 
Exercise 3: 
 
Problem: Decisions about endangered species are rarely as simple as looking at the biology of 
the issues, but they tend to rest first on a biological foundation.  In the first exercise you 
examined numerical aspects of Kirtland’s warbler populations dynamics.  You probably 
observed that most increases in warbler populations come from plantations of jack pines, and 
most of the increase is now occurring off the National Forest, although historically most of it was 
in the Huron National Forest.  In the second exercise you learned to identify Kirtland’s warbler 
habitat and look for issues of habitat isolation and habitat island size.  Here you must make some 
group-based decisions about what ought to be done, and use data from the previous two exercises 
to support your prescription. 
 
Objectives: The final output from this exercise will consider alternative approaches to managing 
for Kirtland’s warbler on USFS lands and recommend a course of action.  Consideration will be 
given to the 5 areas in an environmental impact statement: 

1) an examination of the environmental impacts of the proposed action,  
2) any unavoidable adverse environmental effects of the proposed activity,  
3) any alternatives to the proposed activity,  
4) examine the short-term uses of the environment and the relationships to long-term 

productivity, and  
5) any irreversible and irretrievable commitments of resources involved in the proposed 

action.  
 

� In a small group of 3-4 individuals, list several potential goals for Kirtland’s warbler 
populations on the HMNF and alternatives for habitat management on the national forest, 
assuming the role of USFS personnel.  One alternative required for an EIS is the “do 
nothing” alternative (i.e. not managing for any particular population level of warblers).  
Be creative in selecting 3 alternatives to the “do nothing alternative” such as acquiring 
more land, moving trails, etc.   

 
� Decide on a preferred course of action.   

 
� Using ArcExplorer and the data layers provided as well as the spreadsheet of numerical 

data, create a position paper or a poster that covers the 5 areas of an EIS relative to your 
proposed preferred course of action.  It should state the problem your alternative 
addresses and 1) what effects that alternative will have on the environment (more 
logging, more old-growth habitat or what ever), 2) what adverse effects are unavoidable 
with the proposes alternative (which in effect highlights the negative aspects of 1) 3) 
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what alternatives you considered and briefly how their outcomes differed from the 
preferred alternative, 4) how the short-term uses you propose will affect long-term 
productivity of the national forest, and 5) what irretrievable commitments will need to be 
made for the proposed alternative.  Recognize that a full-blown EIS can cover hundreds 
of pages with volumes of appendices, and that is not the goal of this exercise.  The goal is 
to approach a quantitative question about where and how many Kirtland’s warblers are 
appropriate, identify human-use conflicts that impinge on the purely biological question, 
and recommend some defendable course of action.  Many courses of action could 
legitimately be proposed, but to be effective, they need some sound decision-making.  
The EIS outline takes a proven (if controversial) mechanism of decision-making, one a 
USFS scientist or ranger would have to use, and applies it to the problem at hand.  A 
“correct” solution is not the goal, but rather a defendable one that allows the data to play 
a central role, but not a final role.  Depending on the course needs, the output could be a 
map, some tables, an abbreviated EIS document, a class presentation, or a poster. 

 
Solutions: 
 
Model assumptions: The USFS habitat data assumes homogeneous habitat islands, accurate 
census results, one female for each singing male located, and the same population growth 
performance on any habitat. It also includes subjective evaluations such as that logged areas are 
equal to burned areas despite obvious differences in ground prepration, that Kirtland’s warbler 
should be saved, and that it is acceptable to remove cowbirds to promote Kirtland’s warblers. 
 
The 4 graphs that students should produce in Exercise 1 should look something like: 
 
For overall numbers: 
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For regional numbers: 
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Kirtland's Warblers By Region
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For Logging vs. Fire the fist is the more likely student outcome is: 
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This shows the long-term trend in population really did not change until plantation amounts 
increased.  But the trends in plantation versus wildfire might show better like this: 
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Kirtland's Warbler Habitat

0

200

400

600

800

1000

1200

1400

1990 1995 2000 2005

Year

Si
ng

in
g 

M
al

es

Singing Males -
Michigan
Wildfire

Plantation

Other

 
 
Finally, for the Mack Lake burn, the graph would like about like this: 
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The delay in birds using the habitat is normally 5 years, so the 6 here is not unusual.  And the 
next decade provides optimal habitat that quickly tapers off by year 15 after fire or logging.  
 
The habitat available in 1978 to 1988 is (yellow is selected areas in the search criteria, magent is 
warblers): 
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Older (> 50 years, or before 1950) areas of jack pine available for cutting: 

 
As the Mack Lake island ages, warblers will have to shift out to outlying islands, and focusing 
on habitat islands closer to the core area will facilitate their movements. 
  
 
Suggestions for Instructors: 
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First, download ArcExplorer before class rather than having the students load it.  Students may 
not have write-permission on your machines and they may place the program in different folders 
than you would, making locating the program difficult.  Placing a shortcut for the program on the 
desktop will facilitate its use.   
 
It can be located at the ESRI download site 
(http://gis.esri.com/software/arcexplorer/download4.html).  If you have not done so before, you 
need to register your use of the software, but it is free.  There are versions for Windows, 
Macintosh, Unix, and Linux.  
 
Practice loading file layers and manipulating them, and try to intentionally make some mistakes.  
Students will do this anyway, and being able to recognize mistakes will make recovery faster 
than simply having the student start the exercise all over. 
 
 
Glossary of Terms:  
 
Terms are defined in text as appropriate 
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